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CHAPTER 1

Workspace Overview

In this section, we introduce the workspace and the tools you will 

find there, and also details setting your workspace default settings 

using the Preferences tool.

Topics covered in this chapter:

• Description of the workspace areas

• Overview of the Tools and functions of the workspace tabs.

• Setting up the design workspace environment

• The functions of the Library panel
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The Workspace - 
Overview
The image below shows the Advanced Quilt 

Design workspace, showing the various 

different areas. The sections that follow give a 

brief description of the properties/functions of 

each.

Quick Access Tools
At the top left-hand corner of the window is the 

Quick Access  tool. Click on this button to 

expand a list access to a menu of useful tools, 

such as New, Save, Print, and several others. 

Also on the quick access drop down, a list of 

recent design files will be displayed. Just 

double-click on the file name to open it.

Welcome Screen
When you initially open the program, the 

Welcome screen will open on top of the 

workspace. The welcome screen includes links 

to some very useful web pages, including:

• Blog: Click this link to find a large selection 

of instructional project pages and sewing 

tips. 

• Projects: Links to Brother Embroidery 

Crafting Projects page. On this page, you 

will find downloadable sewing & 

embroidery patterns, ScanNCut projects, 

Brother newsletters, and more.

• Support: This link takes you to the Brother 

Sewing and Embroidery machines page, 

where you will find information on 

machines, software, and finding a Brother 

dealer near you.

• The Events page, which keeps you 

informed about embroidery-related shows 

and events in your vicinity. 

Tool What it means

New Quilt: Creates a new Quilt, which 
opens in its own tab.

New Block: Opens a new tab on which 
you can create a new custom block.

Open: Opens an existing design file.

Save: Saves the current design.

Save As: Opens the Save As dialog, 
allowing you to choose the destination 
and file type to save it as.

Export Image: Creates an image file 
based on the current design, which can 
be saved as a *.bmp, *.jpg, or *.pig file.

Direct Print: Opens the printer dialog on 
your computer, allowing you to choose 
your printer and adjust the printer’s 
properties. 

Print Preview: Opens the print preview 
window, which in turn will let you print the 
current design.

Print Setup: Opens the print setup 
dialog, which allows you to select the 
printer, and to modify print properties.

Exit: Closes all open files and shuts 
down the software; you will be prompted 
to save any open files.

Tool What it means
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Also on the Welcome screen, you will find 

buttons with these functions: Creating a new 

design, opening an existing design, opening 

the most recently used design, and opening 

the help files.

When you open a design or create a new one, 

the Welcome Screen will automatically close. If 

you want to re-open the Welcome screen, 

select the View tab and click the Welcome  

icon.

Workspace Tabs
The four workspace tabs are arrange across 

the top of the Advance Quilt Designer 

workspace. Under these, you will find the tool 

icons for creating and editing quilt projects and 

individual quilt blocks.

Quilt Tab
Refer to the Quilt tab when you are building 

new quilts, or modifying an existing quilt 

design. On this tab, you can set the following 

quilt properties.

• Layout (number of blocks in the quilt, 

across and down)

• Block size (width and height) 

• Sashing: The spacing between blocks in 

the quilt. In the sashing fields, you can 

independently set the horizontal and 

vertical sashing dimensions. You can also 

select the sashing line style (solid/dashed).

• Border: The border settings you can adjust 

include the number of borders, the 

horizontal and vertical dimensions, and the 

border style (corners).

• Block Select  tool.

• Piece Select  tool

• Picture Quilt  tool 

• Quilt Variation  tool.

• Zoom tools: These tools include the Zoom 

in, Zoom out, Zoom to fit, Zoom to fit, and 

Pan tools.

Block Tab
On the Block tab, you will find the tools and 

setting relating to individual quilt blocks. You 

can use the tools to create new custom blocks, 

and to modify existing blocks. 

The following properties of the current Block 

can be adjusted on this tab.

• Style: When you are filling in the piece of a 

custom block with color, the block tab 

overlays an array of “cells” that you select 

and fill in. There are five different styles 

that can be applied: Rectangle, Triangular, 

Triangle up, Triangle down, or On Point. 

For details on the Picture Quilt and Quilt 
Variation Player tools, refer to the 
corresponding sections in the “Using Special 
Design Tools” section of this guide.
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• Across / Down block dimensions: The 

horizontal and vertical dimensions of the 

overlay grid, in terms of the number of cells 

• Width/Height: Absolute size of the block 

(in inches or mm).

• Piece Select  tool.

• Lasso Piece Select  tool.

• Unite  tool: Used merges separate 

pieces in a block/quilt so they can be 

treated as a single piece.

• Break  Up tool: Used to break up 

pieces that have previously been joined 

with the Unite tool.

• Zoom tools: These tools include the Zoom 

in, Zoom out, Zoom to fit, Zoom to fit, and 

Pan tools.

Tools Tab
The tools tab contains tools that can be used 

to select and modify blocks and individual 

pieces in the quilt. It also includes two special 

tools, the Export Project and Color Theme 

designer tools.

• Block Select  tool.

• Piece Select  tool

• Color Theme Designer  tool.

• The Rotate Left  and Rotate Right 

 tools

• Export Project  tool

View Tab
The View tab holds a number of different tools 

that you can use to the change the appearance 

of the workspace. It also includes a number of 

check boxes, which can be checked or 

unchecked to show or hide other workspace 

areas, such as the Color Palettes and the 

Library.

• Welcome Screen  tool.

• Grid  tool: Toggles the workspace grid 

on and off.

• Background  tool: Allows you to 

choose a color or fabric image for the 

workspace background.

• Backdrop  tool: Allows you to place an 

image within pieces. Also included here are 

tools for adjusting the backdrop image. See 

“Loading a Backdrop—Backdrop Settings” 

for or information.

• Show/Hide boxes for the following 

workspace areas:

• Palette

• Block Colors

• Popup Palette

• Status 

• Blocks 

• Library

• The Preferences  tool.

The Program preferences dialog opens 
dialog which allows you to change the 
Environment and Grid settings. For more 
information, see “Setting up the Workspace 
Environment”, later in this chapter



Advanced Quilt Design 7

User’s Guide
Block and Library Panels
The Library and Block panels is located to the 

right side of the workspace. In the Library 

panel, you see a list of categories of blocks, 

including a “Custom” category for the blocks 

you create. 

When you select a category in the Library, the 

Blocks panel will display thumbnail images of 

the quilt blocks in that category. You can then 

drag these onto the Quilt tab to build your quilt.
See Creating a New Quilt–Adding Blocks to a 

Quilt” for details. 

At the top of the library panel there are two 

folders - “My Blocks” and “My Quilts” - into 

which you can save your own blocks and quilt 

designs. Once saved to the library, these will 

be readily available for you to open by 

selecting these folders.

Saving a block or quilt to the library:

1 On the Quick Access  menu, select the 

Save to Library  tool.

You see the Save to library dialog.

The dialog will list any block files (if you are 
saving a block) or quilt files (if you are 
saving a quilt) that have already been saved 
to these folders.

2 In the Name field, enter a new name for the 

block/quilt.

3 Click Save.

The design will be saved to the appropriate 
folder. When you select either the ““My 
Blocks” or “My Quilts” folder, thumbnails of 
the designs will appear in the preview panel 
at the top of the library panel.
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Working with Fill 
Colors

Color Palette
The Palette shows all the available colors that 

you can apply to a quilt block. It consists of a 

series of squares (“swatches”) and is located 

along the bottom of the workspace. You can 

select any color from the Color Palette, and 

add it to the Block colors palette.

To show the Palette, or Block Colors palette 

open the View tab, and check the 

corresponding check box. Alternatively, if you 

want to hide either palette, uncheck the 

corresponding box.

Block Colors Palette
The Block Colors palette shows the colors that 

are used in the current design. This palette 

keeps all the colors that are in use in a single 

array, for easy reference.

To add a color to the Block Colors palette, first 

select a quilt piece using the Piece Select tool. 

Then, on the Color Palette, click on the color 

“swatch” that you want to add. The selected 

piece will be filled with the new color, and this 

color will also be added to the list of Block 

Colors.

The palettes: Block Colors (top) and color Palette 
(below).

Status Line
The Status Line appears at the bottom of the 

Advanced Quilt Design workspace. This line 

displays the dimensions of the quilt or block 

that is currently “on top” in the workspace. 

Note the information in the Status Line 

changes according to the context; when a quilt 

is open, it will show the size of the quilt, and 

when a block tab is open, it will display the 

block size.

Setting up the Work-
space Environment
Advanced Quilt Design allows you to set up 

your design workspace environment for all 

opened design files. You can predetermine the 

units of measurement you want to use for your 

designs, as well as decide how often open 

design files get saved. 

The preferences dialog also allows you choose 

the image editing program to use when editing 

a backdrop image. The designated image 

editing program will open when you select 

Backdrop Tool–Edit Backdrop.
See “Working with Quilts & Quilt Blocks—

Loading a Backdrop Image”).

To set up your workspace environment

1 On the View tab, click the Program 

Preferences  tool.

You see the Preferences dialog box.

2 Click the Environment tab.

You can hide/show the Status line in the 
View toolbar.
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3 From the Units list, select the units of 

measurement you want used for your 

designs: Metric or inches.

4 From the Image editing program list, select 

the image editing program you want to use. 

If you want to use a program not listed, 

select Other Program and browse to the 

location of the program.

5 Click OK.

Setting up the Workspace 
Grid
The workspace grid can be used to help you 

align and measure artwork elements in your 

quilt design. You can display/hide the grid by 

checking/unchecking the box in the area of the 

Home tab.

By default, every horizontal and vertical line 

will be highlighted in the major grid. If you want 

to have additional guide lines, you can add 

more major grid lines as well as a minor grid. 

You can increase or decrease the spacing of 

the minor grid. The minor grid can also have 

different horizontal and vertical spacing 

values.

To make grid lines more visible on particular 

backgrounds, you can change the color of the 

major and minor grids. If you prefer, different 

colors can be applied to the major and minor 

grids.

To define grid settings:

1 On the View tab, click Preferences  

tool and select the Grid tab.

You see the Grid settings dialog.

2 In the Grid Minor area, complete the 

following:

 In the Horizontal spacing box, enter the 
measurements for horizontal spacing in 
millimeters or inches. 

 In the Vertical spacing box, enter the 
measurements for vertical spacing in 
millimeters or inches.

 From the Color list, select a predefined 
color to use for the minor grid. If you 
want to choose from a larger selection 

You can also select the units of measure-
ment in your design workspace; to do this, 
right-click on one of the rulers and select 
Metric or English from the context menu.
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of colors, click Custom from the color 
box.

3 In the Grid Major area, complete the 

following:

 In the Horizontally Every (lines) box, 
enter how often you want horizontal 
lines to be highlighted in the major grid. 
For example, if you enter 3 in this box, 
every third horizontal line will be 
highlighted in the major grid.

 In the Vertically Every (lines) box, enter 
how often you want vertical lines to be 
highlighted in the major grid. For 
example, if you enter 5 in this box, 
every fifth vertical line will be 
highlighted in the major grid.

 From the Color list, select a predefined 
color to use for the major grid. If you 
want to choose from a larger selection 
of colors, click Custom from the color 
box.

4 In the Style area, select one of the 

following grid styles:

 Show grid as solid lines.

 Show grid as dashed lines.

 Show grid as dots.

5 Click OK.

Changing the Workspace 
Background
Depending on the color values of the Quilt or 

Block you are creating, you may want to 

change the background color of the workspace 

to a color other than white, to contrast better; 

or, if you want to use a fabric image as the 

workspace background you can select a fabric 

image instead. You can apply either of these 

options in Advanced Quilt Design.

To change the background color of the 
Workspace: 

1 Select either the View tab. 

2 Click the Background  tool.

3 To change the background to a different 

color, do the following:

 On the drop-down, click Select Color.

You see the colors dialog.

 On the Color dialog, select the desired 
background color from the one of the 
color swatches.

 Click OK.

The new color chosen replaces the old color 
on your design workspace.

4 To change the workspace to show a fabric 

background, do the following:

 On the Background tool drop-down list, 
select Select Fabric.

If you do not see a suitable color in the Basic 
colors matrix (left side of the dialog), click in 
the color “rainbow” on the right to select a 
different color. Then, click “Add to Custom 
Colors”. The new color will now appear in the 
Custom Colors area of the dialog, where it 
can be selected.
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You see the Load Fabric dialog.

 In the Look in field, navigate to the 
directory or folder containing the fabric 
images.

 Select a fabric image, and click OK.

The fabric will appear in the background; 
the image will be tiled so as to fill the 
whole background.

Adding new fabrics to the palette

When “Fabrics” is selected on the Popup 

Palette, an “Add...” button appears on the 

dialog. This button opens a dialog that allows 

you to import new fabric images into the 

palette, so that you can quickly and easily use 

them in designs.

To Add new fabrics:

1 In the Popup Palette, select the Fabrics 

radio button.

2 Click the Add... button in the palette dialog.

You see the Import Fabric dialog.

3 In the Import Fabric dialog, browse to the 

folder containing the fabric images you 

want to add.

4 Select the fabric you want to add by 

clicking on its thumbnail; to select multiple 

images and import them simultaneously, 

hold down the Ctrl key while clicking.

5 Click Open. 

The Import Fabric dialog will close, and the 
selected fabric(s) will now be available in 
the Popup Palette.

Using Zoom Tools
Use Zoom to magnify or reduce in size the 

design view. With Zoom enabled you can 

either left-click to enlarge your design or right-

click to make your design smaller.

When you select Zoom, the cursor changes to 

a small magnifying glass To use the Zoom tool, 

do one of the following: 

• To zoom in on the spot where the mouse is 
currently pointing, left-click.

• To zoom out again, right-click.

• To zoom in on a particular area, left-click 
and drag; the display will expand to show 
only the area that you have dragged over.

To use the Zoom Tool: 

1 On the Tabs bar, select either of the Quilt or 

Block tabs.

2 On the tab, click the Zoom  tool.

The pointer becomes a magnifying glass.

3 Do either of the following:

 Left-click to make your design larger. 

 Right-click that area to make your 
design smaller.

The images you import can be in any of the 
following formats: *.bmp, *.jpg, *.tif, *.pcx, 
*.pct or *.tga.
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Additional Zoom Options 
Aside from the basic Zoom tool, the Zoom area 

of the Quilt and Block tabs include these other 

tools for enlarging/reducing the magnification 

of the workspace:

• Zoom In  to make your design larger.

• Zoom Out to make your design 

smaller.

• To Fit  to make the whole design fit in 

the design window.

• 1:1  to see the design at the actual 

size.

Opening an Existing 
Quilt Design
If you have a quilt or block design that has 

been saved to disk, and you want to modify it, 

use the Open tool.

To open an existing design:

1 On the Quick Access toolbar, click the 

Open  tool. 

You see the Open Design dialog box.

2 In the Look in list, browse to the location of 

the file you want to open.

3 In the File name box, enter the file name, or 

select the file you want to open by clicking 

the file.

4 Select Preview to view a thumbnail (a small 

representation) of the design. 

5 Click Open.

Saving Designs
You can use Save or Save As to save blocks 

and quilt designs.

Save and Save As
The Save As command lets you save an alter-

native version of the design with a different 

name, location, or file format. Save As is 

handy when you want to keep your original 

design and create another design with slight 

modifications. The Save command saves the 

changes you make to the current design.

To save a design:

1 Do one of the following:

 On the Quick Access toolbar, select the 

Save  or Save As  tools.

 Press Ctrl + S on the keyboard.

You see the Save As dialog box.

2 In the Save in list, browse to the location 

you want to save your file. You can save 

design files to your hard drive or external 

memory device.

3 In the File Name box, enter the file name 

for the design you want to be saved.

4 In the Save As type list, select the file type 

you want the design to be saved as.

5 Click Save.

The Quilt or Block will be saved in the 
selected location.

To limit the number of displayed designs in 
the Open Design dialog, you can enter the 
first letter of the design name, followed by an 
asterisk (*) and the file extension.
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Working with Quilts & Quilt 
Blocks

The tools on the Quilt tab and the Block tab are used to create quilt 

designs and quilt blocks. On the library panel, you can select 

existing blocks and drag them onto a quilt grid, in order to put 

together a complete Quilt design. 

You can also make new Blocks and customize the color of the 

pieces within them.

Topics covered in this chapter:

• Assembling new quilts

• Loading a backdrop image.

• Creating a custom quilt block

• Using Block editing tools.

• Outputting designs to the printer

• Exporting designs as image files
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Creating a New Quilt 
When you open a new quilting project, use the 

New Quilt  tool. You will see this tool on 

the Welcome screen when you first open the 

program, or at the top of the workspace on the 

Quick Access toolbar. 

When you open a new quilt, you will see that it 

has some default properties assigned to it; for 

example, it will have a 4× 4 block layout and 8-

in × 8-in blocks. However, these defaults (and 

others) can be adjusted using the control fields 

and options on the Quilt tab -- see the 

following procedure for details.

To create a New Quilt:

1 Do one of the following:

 Click on the New Quilt  tool.

 Press Ctrl+N on the keyboard.

A new quilt grid appears in the workspace, 
on its own tab. 

2 To adjust the properties of the new quilt, 

first select the Quilt tab.

3 In the Blocks area of the Quilt tab, adjust 

the following settings: 

 Set the number of columns and rows of 
blocks in the quilt by entering the 
desired values in the Across and 
Down fields, respectively.

 Adjust the width and/or height of the 
quilt blocks by entering the desired 
values in the Width (in) and Height (in) 
fields, respectively.

4 The Sashing property sets the spacing 

between rows and columns within the Quilt 

Grid. Initially, the quilt will be created 

without sashing. To include sashing in the 

quilt, do the following:

 Enter the desired amount of horizontal 
sashing the Horizontal (in) field.

 Enter the desired amount of vertical 
sashing in the Vertical (in) field. 

 (Optional) Select the Line Style for the 
sashing; from the drop-down list, select 
either Solid or Dashed.

5 In the Border area do the following to 

configure the quilt’s border pieces: 

 Set the number of borders you want 
around the quilt. By default, a new quilt 
will include one border, but you can add 
additional borders by clicking the small 

 icon. (To reduce the number of 

borders, click the small  icon). 

 To adjust the dimensions of the Border 
pieces, do the following: 

 Click on one of the border pieces to 
select it

Note that any of these values can also be 
adjusted up and down by clicking the arrows 
to the right of the corresponding field.
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 In the Height and Width fields, adjust 
the height and width of the selected 
border. 

The border piece size will changed 
accordingly.

 Repeat for other borders, if applicable.

 Select the corner style you want to 
apply to the border pieces. Choose one 
of the following from the drop-down list: 

 Mitered.

 Blocked.

 Strip Horizontal.

 Strip Vertical.

 Repeat for the other borders around the 
quilt, if applicable.

6 Save the Quilt.

Adding Blocks to the Quilt
Once the quilt “grid” (design) has been set up 

as required for your project, you will want to 

add quilt blocks to it. You can add blocks by 

dragging and dropping them directly from the 

Library. You can also build the quilt by cutting 

and pasting blocks within the quilt grid, or by 

dragging a dropping an existing block that is 

already part of the quilt. 

To add a Block to the quilt project:

1 On the Quilt tab, click the Select block  

tool.

2 Click on a block outline to select it.

3 In the Library, click on one of the block 

categories (e.g. Flowers, Paths, Pinwheels, 

etc) to select it.

The blocks in the selected category will now 
be previewed in the Blocks panel.

4 In the Blocks panel, click on the block you 

want to add to select it, then drag and drop 

it to place it on the grid.

The block will be placed in selected square 
of the quilt grid.

5 Repeat the above step(s) to fill each 

square in the grid.

If you have created multiple borders note 
that you can select all borders by right-
clicking and choosing “Select all borders” 
from the context menu. In this way, any 
adjustments you make to the height, width or 
corner style will be applied to all of them 
simultaneously.



16 CHAPTER 2

Working with Quilts & Quilt Blocks
6 Save the Quilt design.

To place blocks by pasting:

1 On the Quilt tab, click the Block Select  

tool.

2 In the Quilt grid, click on the block you want 

to copy and paste. 

3 Click Ctrl+C to copy the selected block.

4 Click in the location you want to place the 

block.

The square will change outline color, to 
show that it has been selected.

5 Left-click to open the context menu. Select 

one of the following paste options:

 Paste (places the block in the selected 
square only).

 Paste to all blocks.

 Paste to selected row.

 Paste to selected column.

 Paste to every other.

The quilt squares will be filled in according 
to the selected
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Some examples of using the paste commands: top, 
Paste to selected row; middle, Paste to selected 
column; bottom, Paste to every other.

To move a block by dragging and 
dropping:

1 On the Quilt tab, click the Block Select  

tool.

2 Click on the block you want to move to 

select it. 

3 Do one of the following:

 To move the block to a new position 
without copying it, click and hold while 
dragging the block to the new location.

 To move and copy the block, hold down 
the Ctrl button while clicking and 
dragging the block.

The block will be copied in the new 
location, and will also remain in the 
original location.

4 Repeat steps 2-3 for all the blocks you 

want to move.

5 Save the quilt to retain the changes.

Editing Individual Blocks 
within a Quilt
It is very simple to make changes to the 

existing blocks of your quilt, and then save the 

modified block back to the quilt.

To Edit a block:

1 On the Quilt tab, click the Block Select  

tool

2 In the design workspace, click a block to 

select it. 

3 Right-click, and select Edit from the menu.

The selected block will open in its own 
separate tab. 

4 Using the tools on the Block tab, edit the 

block. For more information, see “Block 

Editing Tools,” below.

5 Right-click and select Send Block Back to 

Quilt from the context menu.

The modified block now appears in the quilt.

6 Save the quilt design.

Adding a Row or Column 
to a Quilt
Using the commands on the right-click (or 

context) menu, you can add a blank row or 

column to an existing quilt design. Note that 

the row or column can be inserted anywhere in 

the quilt, that is, not just at the edges.

To add a row or column to a quilt:

1 Open a Quilt, or create a new one.

2 On the Quilt tab, click the Select block  

tool.

3 Select a block next to the point where you 

want to add the row or column.
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4 Right-click and choose one of the following 

from the context menu:

 Insert—Row before.

 Insert—Row after.

 Insert—Column before.

 Insert—Column after

The new, blank row or column will be added 
to the quilt as specified. Any blocks that are 
already in the quilt will be “spread out” on 
either side of the new row or column.

Deleting a row or column 
from a quilt
On the right-click menu, you can reduce the 

size of a custom block by deleting the selected 

row or column.

To delete a row or column from a quilt:

1 Open up a quilt design.

2 On the Quit tab, click the Select block  

tool.

3 Select a blocks in the row/or column that 

you want to remove.

4 Right-click and do one of the following:

 Select Remove—Selected row.

 Select Remove—Selected column.

The row or column will be removed from the 
quilt.

5 Save the quilt to preserve your change(s).

Creating New Blocks
You can create new quilt blocks using the New 

Block  tool. When a new block is created, 

it will appear in the “My Blocks” folder of the 

Library.

Loading a Backdrop

You can use the Backdrop  tool to import 

an image file into the workspace to serve as a 

backdrop. You can then use this image as a 

guide for creating new custom quilt blocks with 

the New Block tool; for more information on 

using the New Block tool, see following 

procedure, “Creating a Custom Block”

To load a backdrop image:

1 On the View tab, click the Backdrop  

tool.

You see a drop-down menu.

2 From the menu, select Load Backdrop...

You see the Load Backdrop dialog.

3 In the “Look in” list, navigate to the 

directory containing the backdrop images.

The images appear in the Load Backdrop 
preview window.
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4 Select the backdrop you want to load, and 

click Open.

The backdrop image appears in the 
workspace

Backdrop Settings

You can adjust the size, angle, and luminance 

(color intensity) of the backdrop image on the 

View tab. 

Adjusting the luminance of a backdrop can be 

useful for distinguishing between the 

background colors and the colors you are 

adding as you build your custom block.

Adjusting Backdrop settings:

1 Load a Backdrop image.

2 Adjust one or more of the following:

 Scale (%): Enter a percentage value to 
change the size of the Backdrop image 
(relative to the original size).

 Luminance: Adjusts the color intensity 
of the backdrop; a large numbers 
means a less intense backdrop image 

 Fit to block: When you click this 
option, the backdrop will automatically 
scale up or down so that it fits the 
current block.

 Width and Height: Enter the 
dimensions in these fields to determine 
the size of the Backdrop.

 Angle: Enter the value (in degrees) to 
rotate the Backdrop by.

Showing and Hiding a Backdrop 
Image

Once a backdrop is loaded, you can show and 

hide it using the Backdrop tool. This hides the 

current backdrop (without removing it), so you 

can more clearly see your design work.

To hide the image click the Backdrop  icon 

and un-check “Show backdrop” on the menu. 

To show the backdrop once again, click “Show 

Backdrop” again. 

Editing the Backdrop

If required, you can edit the Backdrop image 

using an external graphic editing program (e.g. 

MS Paint). You can then use this external 

programs to edit the image – change colors or 

resize it, for example – and then save your 

changes. When saved, the modified Backdrop 

image will appear in the Advanced Quilt 

Design workspace. 

To edit the Backdrop using an external 
editor:

1 Load a backdrop image. 
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2 Click the Backdrop Tool  button again 

click Edit Backdrop.

The current backdrop will open in the image 
editing program.

3 Edit the image as desired, and save it.

The modified backdrop image appears in 
the workspace.

Creating a Custom Block

Using the New Block  tool, you can create 

new, unique, quilt blocks of your own. When 

you create a New block, you overlay the 

backdrop image with a “overlay grid” 

consisting of an array of “cells”. You can then 

fill in the pieces of the new block by selecting 

and filling (“coloring in”) cells on this grid.

The completed blocks can then be saved to 

the Custom folder of the Advanced Quilt 

Design’s library, making them available for use 

in assembling quilt blocks. 
See “Adding Blocks to the Quilt” above.

To create a custom block:

1 On the quick access toolbar, select the 

New Block  tool.

A new “Block” tab opens in the workspace.

2 On the Block tab (Properties area), select 

the style to apply to the block grid overlay. 

Choose one of the following

 Rectangle

 Triangular

 Triangle up

 Triangle down

 On point

The style of the overlay grid will change 
accordingly 

3 In the Across and Down fields enter the 

number rows and columns of “cells” in the 

block overlay grid.

4 In the Width and Height fields, you can 

adjust the dimensions of individual “cells” 

in the overlay grid, if required.

5 By default, the “Keep Aspect Ratio” box will 

be checked; when checked, both height 

and width of the “cells” in the grid will be 

scaled proportionally when you adjust 

either dimension. To change one dimension 

without affecting the other,   uncheck “Keep 

aspect ratio” before entering a new value 

for height or width.

6 On the Block tab, click the Piece Select 

 tool. Fill in the colors of the block by 

doing the following:

 On the block overlay grid, click 
individual cells to select them; hold 
down the Ctrl key while clicking to 
select multiple cells.

You can select the image editing program 
that will be used in the Preferences dialog–
Environment tab.

The style chosen should reflect the type of 
backdrop, i.e., use the rectangle style to 
make rectangular blocks and use one of the 
triangular styles if you are creating a block 
with diagonal lines in it.

Note that you can increase or decrease the 
overall block size using steps (3) and (4) 
above. You can do this by increasing/
decreasing the number of cells in the block, 
or increasing/decreasing the width and 
height of the cells that comprise the bloc. 
(Or, use a combination of both methods).
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 Continue clicking on cells until a whole 
piece of the block has been selected.

In this example, all of the cells in the upper-
left triangle of the block are selected.

 To join the cells as a unit, do one of the 
followIng:

 On the Block tab toolbar, click the 

Unite  icon.

 Right-click on the selected pieces, 
and select Unite from the context 
menu.

7 In the Block Color palette, click on a color 

square to change the piece to the desired 

color.

8 Repeat steps 4-6 for the other pieces of the 

block.

9 If required, you can undo the action of the 

Unite tool, so that the selected pieces 

revert to individual “cells.” Select the united 

piece and do one of the following: 

 Click the Break up  tool on the 

Block tab toolbar.

 Right-click on the piece and select 
Break up from the context menu.

10 Using the Save or Save As commands, 

save the block.

The block will be saved as a Outline File 
(*BRF).

Note: Changing Basic Block 
Properties During Editing

Whether you are building a new block or 

editing one of the built-in blocks from the 

library, some basic properties can not be 

changed without resetting the block (that is, 

If you want the custom block to be available 
in the Blocks panel, save it the Library–
Custom folder. By default, this folder will be 
found in the following directory: C\Program 
Data\ Pacesetter \Advanced Quilt 
Design\Library\Custom.
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removing all the color fills and effectively 

creating a brand-new, blank block design). 

These properties are the “style” property 

(Rectangle, Triangle up, Triangle down, etc) 

and the two “number of pieces per block” 

properties (Across and Down). 

If, while editing a block, you do opt to change 

either of these properties, you will see the 

following warning message before the change 

is applied.

There are three options available at this point, 

which are as follows: 

• If you select Yes, a new (blank) block will 

open in a separate tab in the workspace; 

this new block will include the property 

change that you just specified. The original 

block will remain as it was, in its own tab. 

• If you select No, the current block will be 

replaced by a blank block, which has the 

property change that you just specified. 

The original block will be overwritten. (Note 

that you can use the Undo tool to return to 

the block as it was prior to the change). 

• If you select Cancel, no property change 

will be applied to the block.

Block Editing Tools

Selecting a Block

Use the Select Block  tool to select 

individual blocks or block frame in the quilt 

grid. 

When block is selected, you can rotate it, copy 

it, or delete it, by right-clicking and selecting 

the corresponding command from the context 

menu.

Also, you can use the Select tool to select an 

empty block location in the quilt to paste a 

copied block into the quilt.

Selecting a Block Piece

Use the Piece Select  tool or the Lasso 

Piece  select tools to select piece within a 

block or quilt design. When a block piece is 

selected with this tool, you can change its 

color by selecting a color “swatch” from either 

of the palettes. 

To use the Piece Select tool:

1 Select the Block tab or the Quilt tab.

2 Click the Piece Select  tool. There are 

three different ways that you can select 

pieces using this tool:

 To select one individual piece in a 
block, click on it.

 To select a number of adjoining pieces, 
click and drag a rectangular box over 
the pieces you want to select.

Note that the Width & Height properties can 
be adjusted without resetting the block; if 
you make changes either of these 
properties, the block will be re-scaled 
automatically.
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 To select a number of non-adjoining 
pieces, hold down the Ctrl key while 
clicking on the individual pieces.

The selected piece (or group of pieces) will 
now be outlined in blue, indicating that it is 
selected.

To use the Lasso Piece Select tool:

1 Select the Block tab.

2 On the tab, click the Lasso Piece Select 

 tool.

3 In the workspace left-click and drag, 

holding down the button as you trace out a 

line around the pieces you want to select.

4 Release the mouse button.

The pieces within the traced line will be 

outlined in blue, indicating that they are 

selected.

Selecting Similar Pieces 
for Editing
Once a piece has been selected, you can use 

the options on the right-click menu to select 

other pieces of the same size, shape, or 

combination of size and shape. In this way, it is 

possible to select and edit (e.g. change the 

color of) all the similar piece in a block or quilt 

at once.

To select multiple pieces simultaneously:

1 On either the Quilt or Block tabs, click the 

Piece Select  tool. 

2 Select a piece you want to edit, and then 

right-click 

3 On the context menu that appears, choose 

“Select same in block” or “Select same in 

quilt”.

You see a fly-out menu.

4 On the menu, choose one of the following 

options:

 By Color & Shape.

 By Color.

 By Shape.

In the workspace, all the pieces that match 
the original piece will now be selected.

Note that this method can be used both 
when working on a single block or on a 
whole quilt. In the case of working with a 
block, only the “Select same in block” option 
will be available at this point.
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Using the Palettes

Color Palette
The Palette shows all the available colors that 

you can apply to a quilt block. It consists of a 

series of squares (“swatches”) and is located 

along the bottom of the workspace. You can 

select any color from the Color Palette, and 

add it to the Block colors palette.

The palettes: Block Colors palette (top) and Color palette 
(below).

Block Colors Palette
The Block Colors palette shows the colors that 

are used in the design. This palette keeps all 

the colors that are in use in a single array, for 

easy reference. Colors can be added to the 

Block Colors Palette by using either the Piece 

Select tool or the Block select tool.

To add a color to the Block Colors using 
the Piece Select tool:

1 Click on the Piece Select  tool. 

2 Select a block piece using the Piece select 

tool.

3 On the Palette, click the color “swatch” that 

you want to add to the Block Colors palette. 

This color will fill in the select block piece, 
and will be added to the list of Block Colors.

To add a new color the Block Colors 
using the Block Select tool.

1 Click the Block Select  tool.

2 Select one of the border pieces or the 

sashing.

3 On the Palette, click the color “swatch” that 

you want to add to the Block Colors Palette 

This color will fill in the select border or the 
sashing and will be added to the list of 
Block Colors.

Changing Colors with 
Right-click Menu
One way to change the colors of pieces in the 

current block or quilt is through the options 

available the “right-click” or context menu. By 

using these short-cuts to select all pieces that 

have the same shape or size (or combination 

of the two) and change them all at the same 

time.

You can also use the options on the right-click 

menu to change colors of borders; to do this, 

you select the 

To change piece colors using the context 
menu:

1 On the Quilt of Block tab, click the Piece 

Select  tool. 

2 Select the piece that you want to re-color.

3 Right-click and on the context menu that 

appears, choose “Select same in block” or 

“Select same in quilt”, whichever is 

applicable.

You see a fly-out menu.

Note that this method can be used both 
when working on a single block or on a 
whole quilt. In the case of working with a 
block, only the “Select same in block” option 
will be available at this point.
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4 On the menu, choose one of the following 

options:

 By Color & Shape.

 By color.

 By shape.

In the workspace, note that the selected 
pieces will now have thick outlines drawn 
around them.

5 In the Block Colors palette or the Color 

palette, select the color or fabric that you 

want to replace the select color with.

All the selected pieces will now be changed 
to the new color. 

6 Repeat the steps above to change the fill 

color of other pieces in the quilt of block.

7 Save the block or quilt design.

To change the color of borders:

1 On the Quilt tab, select the Block Select 

 tool.

2 Select the border you want to change.

3 Right-click on the selected border.

You see the context menu.

4 On the menu, choose one of the following 

options:

 Select All Borders.

 Select All in this Border

 Select Same Border.
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In the quilt, the selected border (or pieces of 
it) will be highlighted accordingly.

5 In the Block Colors palette or the Color 

palette, select the color or fabric that you 

want to apply.

The selected border/sections of the border 
will be filled with the selected color. 

6 If the Quilt design has more than one 

border, repeat the steps above for the other 

borders.

7 Save the Quilt design.

Changing Colors using the 
“Drag and Drop” method
Another way to change the color of pieces in 

the design is by dragging and dropping one 

color on to another. In this way, you can 

instantly change all pieces of one color to 

another. Note that you can take the color you 

want to use from the Color palette, or use one 

already on the Block palette.

To change colors using Drag and Drop:

1 On the color or block palette, click and hold 

on the color you want to copy into the 

design.

The color square will be outlined showing 
that it has been selected. 

2 Keeping the mouse button depressed, drag 

the new color over the color (on the Block 

palette) that you want to replace.

When the color squares overlap, a small + 
sign will appear next to the cursor.

3 Release the mouse button.

The new color will replace the old one in the 
Block palette and the design.

The “Drag and Drop” method cannot be 
used to change the colors of quilt borders or 
sashing. To color borders or sashing, first 
select them with the Block Select tool, and 
then choose a color from one of the palettes.
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Using the Popup Palette
You can also use the Popup color palette to 

quickly change the color of piece that you have 

selected in the open block. If you are working 

with a whole quilt, you can also use the Popup 

Palette to add colors to/change the color of the 

borders and sashing.

Using the options on the Popup palette, you 

can choose your fill from either (a) the current 

thread chart (b) a fabric image, or (c) a custom 

color selected from the color chooser dialog. 

Each of these methods is described 

individually in the procedures that follow.

To add a fill color from the thread chart:

1 On the either of the Quilt or Block tabs, 

click the Piece select  tool.

2 Select the piece you want to fill with color.

3 In the “Block color” area (lower-left corner 

of the workspace) click the Expand Popup 

Palette  button.

The Popup palette will open, displaying all 
the colors in the current thread chart.

4 To select the thread color, click on the 

corresponding color swatch.

The selected area will be filled with the 
chosen color; note that this color will now be 
added to the “Block colors” palette, if it was 
not already there.

5 Click close Popup  to close the dialog.

There is also an option to use a fabric image 

as the fill for a block piece. The fabric image 

can be selected from the pre-installed fabrics 

library, or you can use your own fabric images. 

To fill a piece with fabric background:

1 On the either of the Quilt or block tabs, 

click the Piece Select  tool.

If you are adding a fill color to the quilt’s 
borders or sashing, use the Block Select tool 
to select it.

If you “hover over” a color swatch, a pop-up 
tag will display the name and thread chart of 
the color in the swatch. 

If you are adding a fabric fill to the quilt’s 
borders or sashing, use the Block Select tool 
to select it.
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2 Select the piece you want to fill with color.

3 In the “Block color” area (lower-left corner 

of the workspace) click the Expand Popup 

Palette  button.

The Popup palette will open.

4 On the Popup palette, click the Fabrics 

radio button.

The palette now displays the list of available 
fabrics. 

5 Click on the fabric you want to use as the 

fill.

The fabric will now fill the selected block 
piece; note also that this fabric will be 
added to the “Block colors” palette, if it was 
not already there.

6 Fabric image options: When the Fabrics 

popup palette is selected, you will see a 

number of new options on the dialog. 

These options allow you to adjust how the 

fabric image will appear. Do one or more of 

the following.

 Crop: Opens a dialog that allows you to 
crop the fabric image, vertically and/or 
horizontally.

 Rotate: Opens a dialog the rotates the 
fabric swatch.

 Scale: You can adjust the scale of the 
fabric image in these fields (horizontal 
and vertical) in order to make closer to 
the scale of the actual fabric that you 
are going to use.

 Offset: You can apply a offset to the 
fabric image These settings change the 
position of the fabric image relative the 
border of the piece in which it has been 
placed. 

 Angle: Enter an angle in this field to 
rotate the fabric image relative to the 
“frame” of the block piece. 

7 Click close Popup  to close the dialog.

To add a custom fill color: 

1 On the either of the Quilt or Block tabs, 

click the Piece Select  tool.

2 Select the piece you want to fill with color.

By default, he “maintain aspect ratio” option 
will be selected, meaning that horizontal and 
vertical changes in the scale will be linked. If 
you want to “skew” the scale of the fabric 
image (i.e. change the vertical or horizontal 
scale percentages independently), you must 
first un-check the “maintain aspect ratio” box

If you are adding custom fail color to the 
quilt’s borders or sashing, use the Block 
Select tool to select it.
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3 In the “Block color” area (lower-left corner 

of the workspace) click the Expand Popup 

Palette  button.

The Popup palette will open.

4 Select the Custom radio button.

The dialog will now display the RGB color 
chooser spectrum.

5 Do one of the following:

 Click in the spectrum to choose the 
color (“hue”) that you want. Adjust to 
“tone’ slider to the right of the spectrum 
to make the color lighter or darker, if 
required. 

 If you already know the Red/Green/
Blue values of your material, enter 
these into the corresponding fields at 
the bottom of the dialog.

Note that, as you adjust the color values, 
the color will be previewed in the preview 
swatch in the bottom-right corner of the 
dialog.

6 Click Close Popup  to close the dialog.

The selected area will be filled with the 
chosen color; note that the custom color will 
now be added to the “Block colors” palette.

Removing Colors using 
the Clear Fills tool
You can remove the color fill from a block 

piece, quilt border, or sashing by using the 

Clear Fills  tool. This tool is located on the 

left side of the Palette bar.

To use the Clear Fills too:

1 Select the item you want to clear:

 Use Piece Select  to select pieces 

within blocks

 Use Block Select  to select borders 

and/or sashing.

2 Click the Clear Fills  tool. 

The fill (color or fabric) will be removed from 
the selected item or items.

Rotating Blocks

The Rotate Left  and Rotate Right  

tools are located on the Tool Tab. You can use 

these tools to rotate blocks both in the Quilt 

View and the Block view.

In the Quilt view, you can select one (or more) 

blocks of a quilt, and rotate them in place; 

each time you click the Rotate tool, the 

You can hold down the CTRL button while 
clicking to multiple individual pieces.
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selected block(s) will be rotated 90 degrees. 

Note that the rotate tools do not change the 

position of the block within the quilt.

In the Block view, the Rotate tools can be used 

to rotate the block to the left or right on its own.

To rotate a block in Quit view: 

1 Open a Quilt design.

2 Click the Block Select  tool.

3 Using the Block Select tool, select the 

block you want to rotate. (To select multiple 

blocks, hold down the Ctrl key while 

clicking subsequent blocks.)

4 Click the Tools tab to display the rotate 

tools.

5 Do one of the following:

 Click the Rotate Left  tool.

 Click the Rotate Right  tool.

The selected block (or blocks) will be 
rotated relative to the quilt.

To rotate a block in Block view:

1 Open a block design.

2 Click the Tools tab to display the rotate 

tools.

3 Do one of the following:

 Click the Rotate Left  tool.

 Click the Rotate Right  tool.

The block will be rotated accordingly.

Correcting Mistakes
Undo and Redo tools allow you to remove or 

re-do an setting change or edit that you have 

made. 

To use Undo: 

• Do one of the following: 

 On the Quick Access toolbar, click the 

Undo  tool. 

 Press Ctrl+Z on your keyboard.

To use Redo: 

• Do one of the following: 

 From the Quick Access toolbar, click 

the Redo  tool.

 Press Ctrl+Y on your keyboard.

Printing Designs
You can make print-outs of your designs in 

Advanced Quilt Design. These print-outs 

create worksheets for all the pieces required 

for the quilt project, Each page of the preview 

will include multiple quilt pieces when possible, 

i.e, when more that one piece will fit per page. 

Also, as an option, the print-out can include a 

dashed outline around each piece to represent 

the seam allowance. This option can be 

enabled/disabled in the Print Settings dialog; 

see “Changing the Print Settings” (below) for 

details on setting print options.

You can also rotate the selected blocks by 
right-clicking on them and selecting one of 
the rotate tools from the context menu.

Note: if Undo or Redo are grayed out, you 
cannot Undo or Redo.



Advanced Quilt Design 31

User’s Guide
An example of one page of a quilt worksheet with the 
Seam Allowance setting enabled.

The print preview includes a color analysis 

page at the very end. This page summarizes 

all the characteristics of the cut pieces - It has 

sections displaying the border and sashing 

dimensions, and includes tables that list all the 

colors used in each quilt block, plus the 

number of cuts required for each color.

Previewing a Design 
before Printing
You can preview a worksheet on the screen 

before sending it to the printer.

To preview the quilt design worksheets:

1 Click the Quick Access  button.

2 On the Quick Access list, click Print — Print 

Preview .

3 To zoom in and out of the previewed 

worksheet, do the following:

 To zoom in on the worksheet, click 
Zoom In and scroll to view specific 
parts of the design.

 To zoom out on the worksheet, click 
Zoom Out and scroll to view specific 
parts of the design.

4 To close print preview and return to the 

design window, click Close.

The print preview will include the border and 
sashing pieces as well, but these will printed 
on separate sheets from the block pieces. 
Since border and sashing pieces are often 
quite large, they might not be printed at full 
size (100% scale), as the others are.
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Printing Design 
Worksheets
You can print a design, without previewing it. 

On the Quick Access tools drop-down list, 

select Print  and then Print Setup . 

This button opens your computer’s Print dia-

log, where you can choose printer options 

such as how many copies you want to print.

You can also print worksheets of your design 

immediately, without previewing the design or 

changing printer options. To do this, use the 

Direct Print  tool.

To print a worksheet for your design:

1 Do one of the following:

 On the Quick Access menu, select 

Print—Print Setup .

 Press Ctrl+P on the keyboard. 

You see the Print Setup dialog.

2 Make any required changes to the print 

settings.

3 Click OK to send the file to the printer.

Changing the Print 
Settings
You can customize print settings for your 

embroidery designs. On the Print settings 

dialog, you to adjust the image and worksheet 

information displayed in design printouts.

To change a design’s print settings:

1 Click the Quick Access  button.

2 On the drop-down list, select the Print—

Print Preview .

You see the print preview window, 
displaying your design.

3 On the preview’s toolbar, click Settings.

You see the Print Settings dialog.

4 In the Margins area, enter the margins 

(Top, Bottom, Left and Right) for your 

design worksheet.

5 Check the Seam allowance box to include 

the seam allowance in the print-out.

6 (Optional) In the seam allowance field, 

adjust the amount (inches) of seam 

allowance to include on the print-out.

7 Sew First Cut Second: When enabled, 

this setting adjusts the print-out of pieces to 

permit the “Sew First Cut Second” sewing 
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method to be used. Where applicable, the 

print-out will have squares in place of 

triangles, and the dimensions of these 

squares will be adjusted to allow for any 

difference in seam allowance that is 

required when using this method.

8 Select Print Company Name to have the 

name of your company name printed on 

your design worksheet. Enter your 

company name in the field underneath this 

check box.

9 Click OK to save the changes to print 

settings.

10 Click Print to output the preview to your 

printer, or Close to exit without printing.

Exporting Designs

Exporting Designs as 
Images
If you want to save or send design as an 

image, you can be exported as images files. 

The Export Image tool can be used to save 

both individual Blocks or whole quilts as an 

image file. You can save the images as *.BMP, 

*.JPG or *.PNG.

To export a design as an image:

1 Open a Quilt or Block design.

2 Click the Quick Access  button, and 

select Export—Export Image  from the 

menu.

You see the Image dialog.

3 In the Save in list, browse to the folder or 

directory you want to save your file. 

4 In the File Name field, enter the file name 

for the design.

5 In the Save as type: field, choose a file type 

to save as - *.BMP, *.JPG, *.PNG or *.GIF.

6 Click Save.

You see the Export Image dialog.

7 Set the size (width and height) of the 

image. 

8 (Optional) Check the Crop Image box to 

remove the white space from around the 

outside of the image.

9 Click OK.

The image of the design will be saved to the 
selected directory

Exporting a quilt or block 
as a Project
Once the design work of the block or quilt is all 

done, you can use the Export Project tool to 

export the cut files to a project folder. Then, 

you can send the cut files (*.FCM) to the 

cutting machine. This 
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To export the quilt block files to the 
Project folder:

1 On the tools tab, click the Export Project 

 tool.

You see the Export dialog

2 By default, the project will be given the 

same name as the file name of the block or 

quilt. However, the project can be re-

named in the Project Name field.

3 Select the output directory: Click the 

browse  button and browse to the 

directory you want to save to.

4 If required, adjust the seam allowance 

setting. The seam allowance sets the 

amount of “extra” border around the fabric 

piece to allow for the fabric that is taken up 

by the finishing stitches.

5 The Spacing setting determines how much 

separation will be inserted between 

individual pieces in the cut file. To override 

the default value, check the “Override 

spacing between Objects” box, and enter a 

new value in the field. 

6 In the Page Size field, select the cutting 

mat size. 

7 To export the blocks as image files, do the 

following:

 Check the Image box.

 From the File Format drop down list, 
select an image file type you want to 
output – *.JPG, *.BMP, or *.PNG.

 Adjust the resolution of the exported 
image in dots per inch (DPI).

8 Click Preview to see a preview the 

design’s worksheets. This will include a 

view of the design (quilt or block) followed 

by images of all the cut files (pieces) in the 

project, grouped by color.

9 (Optional) Select the Print to Scan” check 

box. When enabled, each of the pieces will 

be output as an outline in the print preview, 

suitable for scanning on certain types of 

cutting machines.

10 Click Export.

The Export dialog will close, and the cut files 

and embroidery files will be sent to the project 

folder.
A browser dialog will open automatically, 

showing the project folder directory; in this 

directory, you will see all the cut files in the 

project.

 Note that the cut images on the print 
preview pages will include the seam 
allowance.



CHAPTER 3

Using Special Design Tools

Advanced Quilt Design includes a number of special design tools 

that allow you to make new and creative in your block and whole 

quilt designs.

Topics covered in this chapter:

• Using the Quilt Variation Player to generate series of different 

quilt designs base on a given set of blocks

• Using the Color Theme Designer to vary the set of colors in a 

block, by applying a color theme or tint.

• Creating quilt designs from an imported image file with using 

the Picture Quilt tool.
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Quilt Variation Player

The Quilt Variation Player  is a special 

creative tool that allows you create a number 

of different quilt designs, by rearranging the 

blocks of the current quilt in different ways. 

This tool includes a number of different 

Variation options, which determine how the 

blocks will be rearranged. For example, “Rows 

and columns” will only arrange the block 

horizontal rows and verticals columns; the 

“diagonal” options will only create diagonal 

arrangements; and so on.

The Quilt Variation Player includes a “player” 

feature, which automatically “Plays through” all 

the possible different arrangements that our 

possible within the Variation you have 

selected; or, if you prefer, there is a tool that 

you allows you to go through the permutations 

one at a time.

To use the Quilt Variation Player:

1 Open a quilt or create a new one.

2 On the Quilt toolbar, click the Quilt 

Variation Player  tool.

The Quilt Variation Player dialog opens.

Note that all the blocks in the quilt will be 
listed in the column on the left; in the middle 
column, you will see the list of available 
Variations.

3 In the Variations column, select a variation 

to apply.

4 Depending on which variation you choose, 

there may be a large number of different 

arrangements that can be made of the 

blocks; to view these different 

arrangements, do one of the following:

 Click the “Play”  button to play 

through the different possible variations 
automatically one at a time.

 To stop the player click the “stop”  

button.

 Click the “Next variation”  button to 

go through these different combinations 

one at a time.

 To move backwards through the 
different combinations, click the 

“Previous variation”  button.

 If you chose the “Random” variation, 
you have option of rotating the blocks 
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within the quilt. Click on the “Rotate” 

 button to randomly vary the 

orientation of blocks within the quilt.

5 When you are finished browsing through 

the variations, click OK. 

The Quilt Variation Player dialog will close, 
and the latest variation will open in the 
workspace as a new quilt.

6 Save the design.

Color Theme Designer
The Color Theme Designer  tool is used to 

change the overall appearance of a design 

(Quilt OR Block) by adjusting its color scheme. 

There are a number of different ways in which 

this tool can be used to adjust the design’s 

colors:

• Lighten or Darken: In these options, the 

Color Theme Designer analyzes the colors 

of the pieces, and substitutes new colors of 

a similar hue but different intensity (i.e., 

lighter or darker, depending on which you 

choose). 

• Tint: All selected colors will be adjusted 

according to the color you choose in the 

color chooser dialog. So, for example, if 

you select orange in the dialog, the colors 

in your design will all be converted to a 

correspond range of orange colors.

• Theme: A wide range of color themes 

come pre-loaded with the software. When 

you apply a theme, the software looks at 

the selected colors in the design, and 

substitutes for each color from the Theme 

set that is closest in value.

• Note that you can choose which colors will 

be affected by Color Theme Designer. By 

default, all colors in the design will be 

selected, so they will all be adjusted. 

However, if you only want to some colors to 

be changed, you can uncheck the boxes 

next to the colors that you want to remain 

constant.

• There is also an option on the Color Theme 

Designer dialog that allows you to include 

or exclude the Border pieces and sashing 

from the color changes.

To use the Color Theme Designer tool:

1 Open a quilt or block design (for the 

purposes of this procedure, an single block 

will be used as an example).

2 On the Tools tab, select the Color Theme 

Designer  tool.

You see the Color Theme Designer dialog 
window. 

If you have applied any of the color 
adjustments and want to “step back” in the 
process, do this by clicking on the “Undo” 
button. You can also re-apply the change by 
clicking the “Redo” button.
Click the “Reset” button to return the Block or 
Quilt to its original colors.
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The dialog includes a preview of the image, 
and a list of the design’s colors.

3 To lighten or darken colors, do one of the 

following:

 Click the Lighter  icon to substitute 

lighter colors for current design colors.

 Click the Darker  icon to substitute 

darker colors for current design colors.

 Repeat as many times as required to 
achieve the desired color level.

A darkened quilt design.

4 To substitute random colors for the design 

piece colors, click the Randomize  

icon.

5 To change the Tint of the design’s color 

scheme, do the following.

 Click the Apply Tint...  button.

You see a Color dialog. 

 In the Color dialog, select the tint color 
you want to apply.

 Click OK. 

The Color dialog will close. In the Color 
Theme Designer dialog, the preview 
window will reflect the changes

6 To apply a Theme, do the following:

 In the Color Theme Designer dialog, 

click the Theme  icon.

You see the Themes dialog.

Colors can be selected from the color 
“swatches” on the left, or you can click in the 
color palette on the right to create a custom 
color. If using the palette, note that the slider 
on the far right controls the light/dark 
balance of the custom color.
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 Tick the box next to the theme you want 
to apply.

 Click OK.

The Color Theme Designer Themes dialog 
will close. In the Color Theme Designer 
preview window, you will see that the colors 
have been changed to those in the selected 
Theme.

7 Borders option (applies to quilt designs 

only). By default, the “Borders” option will 

be selected. When it is, this means that the 

border pieces and sashing will be have 

their colors adjusted (along with the rest of 

the quilt) in any color theme changes that 

you make.

If you deselect the Borders option, note that 
the borders and sashing will disappear from 
the preview pane.

8 Click OK to close the dialog and complete 

the color changes.

The design will appear in the workspace 
with the new color scheme. 

Picture Quilt Tool

Using the Picture Quilt  tool, you can 

convert any image you have into a quilt design. 

The Picture Quilt takes the image that you 

open in it and generates a series of quilt 

blocks or pieces which you then print off. 

Alternatively, you could export the pieces as a 

FCM file for output to an automatic cutting 

machine.

Step 1: Selecting an image 

1 On the Quilt toolbar, select the Picture Quilt 

 tool.

You see an “Open” dialog.

2 In the dialog, browse to the location of the 

image file you want to use as the basis for 

the quilt.

3 Select the image, and click Open.

You see the Picture Quilt Crop page.

At any time, you can click the Reset button to 
change the design back to the original 
colors.

If you want to replace the image with a 
different one at this stage, you can click the 

“Select file”  icon at the top of the dialog. 

This will open a new dialog, allowing you to 
open a new image file.
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Step 2: Crop the image

1 If required to get a better view of the 

imported image, you can adjust the image 

preview in the window with the zoom tools. 

 Click  to zoom in.

 Click  to zoom out. 

 Click the “Fit image”  icon to fit the 

image to the window.

2 To crop any unwanted background from the 

imported image drag the Top, Bottom, Left 

and Right slider controls. 

The number of pixels to the right of each 
slider will update automatically as you move 
these controls they represent the distance 
(number of pixels) of each crop bar from the 
top-left corner of the image.
Note also that the dimensions of the image, 
after cropping, will be displayed beneath the 
sliders.

3 Click Next.

You see the pieces page.

Step 3: Setting the quilt, piece, and block 
dimensions

On the Pieces page, you can determine the 

overall size of the quilt, and set the piece size 

(in inches) the block dimensions.

1 Under the heading “Quilt size without 

borders and sashing”, enter the overall quilt 

dimensions (in inches). Note that only the 

smaller of the two dimensions will be 

editable; the other dimension will be scaled 

automatically to maintain the quilt’s 

proportion.

2 In the “Piece size” field, enter the piece 

size you want to use.
Note that the status line immediately 

underneath the “Piece size” field shows the 

number of pieces and piece dimensions of 

the quilt (i.e. number of pieces wide by the 

number of pieces high).

3 To divide the quilt into blocks, tick the “Use 

blocks” check box. 

The Block Size fields will become editable. 
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4 In the block size fields, enter the block 

dimensions (width X height).

In the preview window, you see blue lines 
delineating the blocks. Underneath the 
block size fields, the dialog will display the 
number of blocks in the quilt, plus the 
number pieces in each block. 

Tip: Redistributing unfilled pieces 

When the design have been broken up into 

blocks, you may find (depending on the block 

dimensions and the quilt size) that some 

blocks may have only a few filled pieces. For 

example, in the project below, you see that the 

main image is justified to the left, and so all the 

blocks on the right side only have filled pieces 

in the first column. 

If you want to redistribute the filled areas 

better, you can do so by dragging the slider 

control at the bottom of the “blocks” area of the 

dialog (as in the example below).

5 Click Next.

6 You see the Picture Quilt colors page.

Step 4: Adjusting colors in the design.

The tools on the color page allow you to 

reduce the number of colors in a quilt (if 

necessary) in order to simplify it.
The Colors page also includes pick color, 

pencil, and bucket tools, which can be used to 

add color to empty pieces, if necessary.

Note that you can use the tools on the 
“Colors” page to fill in the piece on the edge 
of the quilt design. See Step 3 for details.
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1 To decrease the number of colors, drag the 

“Number of Colors” slider to the left; as you 

move this control the least-used color will 

be left off first.

2 To simplify a design that has a few isolated 

areas of color, check the “Clear small 

spots” box. This option automatically 

removes such areas by changing their color 

to that of larger areas of a similar color, 

thus reducing the total of number of colors 

overall.

3 To re-color pieces in the design manually, 

do the following:

 Select the “pick color”  tool, and 

click on the color you want to use as 
the fill color.

The color will be “loaded” onto the pencil 
and bucket tools, and will remain so until 
you pick a different color.

 To fill one or more pieces individually, 

select the “pencil”  tool and click on 

the piece(s) that you want to re-color. 

The individual piece squares will be filled 
with the new color.

 To fill a larger area, select the “bucket” 

 tool and click on a piece that you 

want to re-color. 

The selected piece and all adjacent 
pieces of the same color, will be filled 
with the new color.

4 On the Picture Quilt dialog, click “Finish”.

The finished quilt design appears in the 
workspace. 

5 Save the quilt.

You can drag the slider back to the right to 
put the colors back in the design.
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	CHAPTER 1
	Workspace Overview

	In this section, we introduce the workspace and the tools you will find there, and also details setting your workspace default settings using the Preferences tool.
	Topics covered in this chapter:
	The Workspace - Overview
	Quick Access Tools
	Welcome Screen

	Workspace Tabs
	Quilt Tab
	Block Tab
	Tools Tab
	View Tab
	Block and Library Panels
	Saving a block or quilt to the library:
	1 On the Quick Access menu, select the Save to Library tool.
	2 In the Name field, enter a new name for the block/quilt.
	3 Click Save.



	Working with Fill Colors
	Color Palette
	Block Colors Palette
	Status Line

	Setting up the Workspace Environment
	To set up your workspace environment
	1 On the View tab, click the Program Preferences tool.
	2 Click the Environment tab.
	3 From the Units list, select the units of measurement you want used for your designs: Metric or inches.
	4 From the Image editing program list, select the image editing program you want to use. If you want to use a program not listed, select Other Program and browse to the location of the program.
	5 Click OK.

	Setting up the Workspace Grid
	To define grid settings:
	1 On the View tab, click Preferences tool and select the Grid tab.
	2 In the Grid Minor area, complete the following:
	3 In the Grid Major area, complete the following:
	4 In the Style area, select one of the following grid styles:
	5 Click OK.


	Changing the Workspace Background
	To change the background color of the Workspace:
	1 Select either the View tab.
	2 Click the Background tool.
	3 To change the background to a different color, do the following:
	4 To change the workspace to show a fabric background, do the following:

	Adding new fabrics to the palette
	To Add new fabrics:
	1 In the Popup Palette, select the Fabrics radio button.
	2 Click the Add... button in the palette dialog.
	3 In the Import Fabric dialog, browse to the folder containing the fabric images you want to add.
	4 Select the fabric you want to add by clicking on its thumbnail; to select multiple images and import them simultaneously, hold down the Ctrl key while clicking.
	5 Click Open.



	Using Zoom Tools
	To use the Zoom Tool:
	1 On the Tabs bar, select either of the Quilt or Block tabs.
	2 On the tab, click the Zoom tool.
	3 Do either of the following:

	Additional Zoom Options


	Opening an Existing Quilt Design
	To open an existing design:
	1 On the Quick Access toolbar, click the Open tool.
	2 In the Look in list, browse to the location of the file you want to open.
	3 In the File name box, enter the file name, or select the file you want to open by clicking the file.
	4 Select Preview to view a thumbnail (a small representation) of the design.
	5 Click Open.


	Saving Designs
	Save and Save As
	To save a design:
	1 Do one of the following:
	2 In the Save in list, browse to the location you want to save your file. You can save design files to your hard drive or external memory device.
	3 In the File Name box, enter the file name for the design you want to be saved.
	4 In the Save As type list, select the file type you want the design to be saved as.
	5 Click Save.
	CHAPTER 2



	Working with Quilts & Quilt Blocks


	The tools on the Quilt tab and the Block tab are used to create quilt designs and quilt blocks. On the library panel, you can select existing blocks and drag them onto a quilt grid, in order to put together a complete Quilt design.
	You can also make new Blocks and customize the color of the pieces within them.
	Topics covered in this chapter:
	Creating a New Quilt
	To create a New Quilt:
	1 Do one of the following:
	2 To adjust the properties of the new quilt, first select the Quilt tab.
	3 In the Blocks area of the Quilt tab, adjust the following settings:
	4 The Sashing property sets the spacing between rows and columns within the Quilt Grid. Initially, the quilt will be created without sashing. To include sashing in the quilt, do the following:
	5 In the Border area do the following to configure the quilt’s border pieces:
	6 Save the Quilt.

	Adding Blocks to the Quilt
	To add a Block to the quilt project:
	1 On the Quilt tab, click the Select block tool.
	2 Click on a block outline to select it.
	3 In the Library, click on one of the block categories (e.g. Flowers, Paths, Pinwheels, etc) to select it.
	4 In the Blocks panel, click on the block you want to add to select it, then drag and drop it to place it on the grid.
	5 Repeat the above step(s) to fill each square in the grid.
	6 Save the Quilt design.

	To place blocks by pasting:
	1 On the Quilt tab, click the Block Select tool.
	2 In the Quilt grid, click on the block you want to copy and paste.
	3 Click Ctrl+C to copy the selected block.
	4 Click in the location you want to place the block.
	5 Left-click to open the context menu. Select one of the following paste options:

	To move a block by dragging and dropping:
	1 On the Quilt tab, click the Block Select tool.
	2 Click on the block you want to move to select it.
	3 Do one of the following:
	4 Repeat steps 2-3 for all the blocks you want to move.
	5 Save the quilt to retain the changes.


	Editing Individual Blocks within a Quilt
	To Edit a block:
	1 On the Quilt tab, click the Block Select tool
	2 In the design workspace, click a block to select it.
	3 Right-click, and select Edit from the menu.
	4 Using the tools on the Block tab, edit the block. For more information, see “Block Editing Tools,” below.
	5 Right-click and select Send Block Back to Quilt from the context menu.
	6 Save the quilt design.


	Adding a Row or Column to a Quilt
	To add a row or column to a quilt:
	1 Open a Quilt, or create a new one.
	2 On the Quilt tab, click the Select block tool.
	3 Select a block next to the point where you want to add the row or column.
	4 Right-click and choose one of the following from the context menu:


	Deleting a row or column from a quilt
	To delete a row or column from a quilt:
	1 Open up a quilt design.
	2 On the Quit tab, click the Select block tool.
	3 Select a blocks in the row/or column that you want to remove.
	4 Right-click and do one of the following:
	5 Save the quilt to preserve your change(s).



	Creating New Blocks
	Loading a Backdrop
	To load a backdrop image:
	1 On the View tab, click the Backdrop tool.
	2 From the menu, select Load Backdrop...
	3 In the “Look in” list, navigate to the directory containing the backdrop images.
	4 Select the backdrop you want to load, and click Open.

	Backdrop Settings
	Adjusting Backdrop settings:
	1 Load a Backdrop image.
	2 Adjust one or more of the following:


	Showing and Hiding a Backdrop Image
	Editing the Backdrop
	To edit the Backdrop using an external editor:
	1 Load a backdrop image.
	2 Click the Backdrop Tool button again click Edit Backdrop.
	3 Edit the image as desired, and save it.



	Creating a Custom Block
	To create a custom block:
	1 On the quick access toolbar, select the New Block tool.
	2 On the Block tab (Properties area), select the style to apply to the block grid overlay. Choose one of the following
	3 In the Across and Down fields enter the number rows and columns of “cells” in the block overlay grid.
	4 In the Width and Height fields, you can adjust the dimensions of individual “cells” in the overlay grid, if required.
	5 By default, the “Keep Aspect Ratio” box will be checked; when checked, both height and width of the “cells” in the grid will be scaled proportionally when you adjust either dimension. To change one dimension without affecting the other, unc...
	6 On the Block tab, click the Piece Select tool. Fill in the colors of the block by doing the following:
	7 In the Block Color palette, click on a color square to change the piece to the desired color.
	8 Repeat steps 4-6 for the other pieces of the block.
	9 If required, you can undo the action of the Unite tool, so that the selected pieces revert to individual “cells.” Select the united piece and do one of the following:
	10 Using the Save or Save As commands, save the block.

	Note: Changing Basic Block Properties During Editing


	Block Editing Tools
	Selecting a Block
	Selecting a Block Piece
	To use the Piece Select tool:
	1 Select the Block tab or the Quilt tab.
	2 Click the Piece Select tool. There are three different ways that you can select pieces using this tool:

	To use the Lasso Piece Select tool:
	1 Select the Block tab.
	2 On the tab, click the Lasso Piece Select tool.
	3 In the workspace left-click and drag, holding down the button as you trace out a line around the pieces you want to select.
	4 Release the mouse button.


	Selecting Similar Pieces for Editing
	To select multiple pieces simultaneously:
	1 On either the Quilt or Block tabs, click the Piece Select tool.
	2 Select a piece you want to edit, and then right-click
	3 On the context menu that appears, choose “Select same in block” or “Select same in quilt”.
	4 On the menu, choose one of the following options:



	Using the Palettes
	Color Palette
	Block Colors Palette
	To add a color to the Block Colors using the Piece Select tool:
	1 Click on the Piece Select tool.
	2 Select a block piece using the Piece select tool.
	3 On the Palette, click the color “swatch” that you want to add to the Block Colors palette.

	To add a new color the Block Colors using the Block Select tool.
	1 Click the Block Select tool.
	2 Select one of the border pieces or the sashing.
	3 On the Palette, click the color “swatch” that you want to add to the Block Colors Palette


	Changing Colors with Right-click Menu
	To change piece colors using the context menu:
	1 On the Quilt of Block tab, click the Piece Select tool.
	2 Select the piece that you want to re-color.
	3 Right-click and on the context menu that appears, choose “Select same in block” or “Select same in quilt”, whichever is applicable.
	4 On the menu, choose one of the following options:
	5 In the Block Colors palette or the Color palette, select the color or fabric that you want to replace the select color with.
	6 Repeat the steps above to change the fill color of other pieces in the quilt of block.
	7 Save the block or quilt design.

	To change the color of borders:
	1 On the Quilt tab, select the Block Select tool.
	2 Select the border you want to change.
	3 Right-click on the selected border.
	4 On the menu, choose one of the following options:
	5 In the Block Colors palette or the Color palette, select the color or fabric that you want to apply.
	6 If the Quilt design has more than one border, repeat the steps above for the other borders.
	7 Save the Quilt design.


	Changing Colors using the “Drag and Drop” method
	To change colors using Drag and Drop:
	1 On the color or block palette, click and hold on the color you want to copy into the design.
	2 Keeping the mouse button depressed, drag the new color over the color (on the Block palette) that you want to replace.
	3 Release the mouse button.


	Using the Popup Palette
	To add a fill color from the thread chart:
	1 On the either of the Quilt or Block tabs, click the Piece select tool.
	2 Select the piece you want to fill with color.
	3 In the “Block color” area (lower-left corner of the workspace) click the Expand Popup Palette button.
	4 To select the thread color, click on the corresponding color swatch.
	5 Click close Popup to close the dialog.

	To fill a piece with fabric background:
	1 On the either of the Quilt or block tabs, click the Piece Select tool.
	2 Select the piece you want to fill with color.
	3 In the “Block color” area (lower-left corner of the workspace) click the Expand Popup Palette button.
	4 On the Popup palette, click the Fabrics radio button.
	5 Click on the fabric you want to use as the fill.
	6 Fabric image options: When the Fabrics popup palette is selected, you will see a number of new options on the dialog. These options allow you to adjust how the fabric image will appear. Do one or more of the following.
	7 Click close Popup to close the dialog.

	To add a custom fill color:
	1 On the either of the Quilt or Block tabs, click the Piece Select tool.
	2 Select the piece you want to fill with color.
	3 In the “Block color” area (lower-left corner of the workspace) click the Expand Popup Palette button.
	4 Select the Custom radio button.
	5 Do one of the following:
	6 Click Close Popup to close the dialog.


	Removing Colors using the Clear Fills tool
	To use the Clear Fills too:
	1 Select the item you want to clear:
	2 Click the Clear Fills tool.


	Rotating Blocks
	To rotate a block in Quit view:
	1 Open a Quilt design.
	2 Click the Block Select tool.
	3 Using the Block Select tool, select the block you want to rotate. (To select multiple blocks, hold down the Ctrl key while clicking subsequent blocks.)
	4 Click the Tools tab to display the rotate tools.
	5 Do one of the following:

	To rotate a block in Block view:
	1 Open a block design.
	2 Click the Tools tab to display the rotate tools.
	3 Do one of the following:


	Correcting Mistakes
	To use Undo:
	To use Redo:


	Printing Designs
	Previewing a Design before Printing
	To preview the quilt design worksheets:
	1 Click the Quick Access button.
	2 On the Quick Access list, click Print — Print Preview .
	3 To zoom in and out of the previewed worksheet, do the following:
	4 To close print preview and return to the design window, click Close.


	Printing Design Worksheets
	To print a worksheet for your design:
	1 Do one of the following:
	2 Make any required changes to the print settings.
	3 Click OK to send the file to the printer.


	Changing the Print Settings
	To change a design’s print settings:
	1 Click the Quick Access button.
	2 On the drop-down list, select the Print— Print Preview .
	3 On the preview’s toolbar, click Settings.
	4 In the Margins area, enter the margins (Top, Bottom, Left and Right) for your design worksheet.
	5 Check the Seam allowance box to include the seam allowance in the print-out.
	6 (Optional) In the seam allowance field, adjust the amount (inches) of seam allowance to include on the print-out.
	7 Sew First Cut Second: When enabled, this setting adjusts the print-out of pieces to permit the “Sew First Cut Second” sewing method to be used. Where applicable, the print-out will have squares in place of triangles, and the dimensions of these...
	8 Select Print Company Name to have the name of your company name printed on your design worksheet. Enter your company name in the field underneath this check box.
	9 Click OK to save the changes to print settings.
	10 Click Print to output the preview to your printer, or Close to exit without printing.



	Exporting Designs
	Exporting Designs as Images
	To export a design as an image:
	1 Open a Quilt or Block design.
	2 Click the Quick Access button, and select Export—Export Image from the menu.
	3 In the Save in list, browse to the folder or directory you want to save your file.
	4 In the File Name field, enter the file name for the design.
	5 In the Save as type: field, choose a file type to save as - *.BMP, *.JPG, *.PNG or *.GIF.
	6 Click Save.
	7 Set the size (width and height) of the image.
	8 (Optional) Check the Crop Image box to remove the white space from around the outside of the image.
	9 Click OK.


	Exporting a quilt or block as a Project
	To export the quilt block files to the Project folder:
	1 On the tools tab, click the Export Project tool.
	2 By default, the project will be given the same name as the file name of the block or quilt. However, the project can be re- named in the Project Name field.
	3 Select the output directory: Click the browse button and browse to the directory you want to save to.
	4 If required, adjust the seam allowance setting. The seam allowance sets the amount of “extra” border around the fabric piece to allow for the fabric that is taken up by the finishing stitches.
	5 The Spacing setting determines how much separation will be inserted between individual pieces in the cut file. To override the default value, check the “Override spacing between Objects” box, and enter a new value in the field.
	6 In the Page Size field, select the cutting mat size.
	7 To export the blocks as image files, do the following:
	8 Click Preview to see a preview the design’s worksheets. This will include a view of the design (quilt or block) followed by images of all the cut files (pieces) in the project, grouped by color.
	9 (Optional) Select the Print to Scan” check box. When enabled, each of the pieces will be output as an outline in the print preview, suitable for scanning on certain types of cutting machines.
	10 Click Export.
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	Using Special Design Tools


	Advanced Quilt Design includes a number of special design tools that allow you to make new and creative in your block and whole quilt designs.
	Topics covered in this chapter:
	Quilt Variation Player
	To use the Quilt Variation Player:
	1 Open a quilt or create a new one.
	2 On the Quilt toolbar, click the Quilt Variation Player tool.
	3 In the Variations column, select a variation to apply.
	4 Depending on which variation you choose, there may be a large number of different arrangements that can be made of the blocks; to view these different arrangements, do one of the following:
	5 When you are finished browsing through the variations, click OK.
	6 Save the design.


	Color Theme Designer
	To use the Color Theme Designer tool:
	1 Open a quilt or block design (for the purposes of this procedure, an single block will be used as an example).
	2 On the Tools tab, select the Color Theme Designer tool.
	3 To lighten or darken colors, do one of the following:
	4 To substitute random colors for the design piece colors, click the Randomize icon.
	5 To change the Tint of the design’s color scheme, do the following.
	6 To apply a Theme, do the following:
	7 Borders option (applies to quilt designs only). By default, the “Borders” option will be selected. When it is, this means that the border pieces and sashing will be have their colors adjusted (along with the rest of the quilt) in any color them...
	8 Click OK to close the dialog and complete the color changes.


	Picture Quilt Tool
	Step 1: Selecting an image
	1 On the Quilt toolbar, select the Picture Quilt tool.
	2 In the dialog, browse to the location of the image file you want to use as the basis for the quilt.
	3 Select the image, and click Open.

	Step 2: Crop the image
	1 If required to get a better view of the imported image, you can adjust the image preview in the window with the zoom tools.
	2 To crop any unwanted background from the imported image drag the Top, Bottom, Left and Right slider controls.
	3 Click Next.

	Step 3: Setting the quilt, piece, and block dimensions
	1 Under the heading “Quilt size without borders and sashing”, enter the overall quilt dimensions (in inches). Note that only the smaller of the two dimensions will be editable; the other dimension will be scaled automatically to maintain the quil...
	2 In the “Piece size” field, enter the piece size you want to use. Note that the status line immediately underneath the “Piece size” field shows the number of pieces and piece dimensions of the quilt (i.e. number of pieces wide by the number ...
	3 To divide the quilt into blocks, tick the “Use blocks” check box.
	4 In the block size fields, enter the block dimensions (width X height).

	Tip: Redistributing unfilled pieces
	5 Click Next.
	6 You see the Picture Quilt colors page.
	Step 4: Adjusting colors in the design.
	1 To decrease the number of colors, drag the “Number of Colors” slider to the left; as you move this control the least-used color will be left off first.
	2 To simplify a design that has a few isolated areas of color, check the “Clear small spots” box. This option automatically removes such areas by changing their color to that of larger areas of a similar color, thus reducing the total of number o...
	3 To re-color pieces in the design manually, do the following:
	4 On the Picture Quilt dialog, click “Finish”.
	5 Save the quilt.
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